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Chapter 1 - Introduction to the ISOMAP family

Introduction to the ISOMAP family

The ISOMAP family is an integrated software package that allows one to create a digital terrain model (DTM)
that can be used for further elaborations, such as rockfall analysis and groundwater modelling.

The ISOMAP module allows one to create a grid from a set of spot points, and to produce maps, wireframe
views, or solid views. It allows different calculations, such as slope mapping, exposure mapping, or filtering.

See "Introduction to the ISOMAP module" for further information.

The ROTOMAP module is dedicated to 3D rockfall analysis, and allows the complete design of rockfall
protective systems. It features true 3D modelling and many other options for model calibration and barrier
design.

See "Introduction to the module ROTOMAP" for further information.

The INQIMAP module is dedicated to groundwater modelling. It leads to calculations from those based on
simple analytical solutions to those that incorporate advanced and complex numerical techniques.

The "Introduction to the INQUIMAP module" and the subsequent chapters are not included in the present
version of the manual.

The ISOMAP family is a comprehensive package: it can directly produce high-quality graphic outputs, or export
them to DXF or EMF formats, which preserve the vectorial quality of the printouts, even when the files are
imported into external editors such as Microsoft Word or Corel Draw.
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System requirements

Chapter 2 - System requirements and program
Installation

Pentium® class processor

Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

64 MB of RAM (128 MB recommended)
100 MB of available hard-disk space
CD-ROM drive

Program Installation

A printer driver must be installed, even if the printer itself is not connected to the PC.

Winfip Self-Extractor - rotomap32setup._exe

ﬁ?;g Prezs SETUP to ztart inztallation
/5 e

To install ROTOMAP run the rotomap32setup.exe installation package from the CD-ROM or from the
download directory.

About

Cancel |
|

Press the Setup button...

HOTOMAFSZ Setup

Chooss e installalion dieectog

e
__| My Documesiz
N Progism Files

D pom havwe an hardwae pokection key?

I am namming & demas yersion,
N et a0 praialle] key
res, | have a USH key

_. Haza bz Bhaz dlicliaalt cordiguistin of coliumns, s aml lesuies

...and select the directory to create the ROTOMAP32 folder.

Click the Continue button and the program program is automatically installed.
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The first time you run the program the window that allows you to select your preferred language appears. Simply
click on the flag of the language you prefer.

Select your language...
i BN ==

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program protection

Hardware protection key

This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port

Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.

The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me

Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP

Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port

Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

-
y

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP

All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
to load the driver from. To install the driver, follow this procedure:

1. start Windows, and login as Administrator (if necessary)
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2. install the package

3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT

Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator
2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer
To uninstall the software driver, follow this procedure:
1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a local
network

Using the program in a local network

The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each

Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be

found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe

Run keyserver.exe and the hardware key management window appears.

[ LocalHost P 195851521 Crmals Progears Cordiguraon File: |

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\rotomap32\rotomap32.exe). Now, with the
keyserver.exe program running, rotomap32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations

Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.
CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

e KEY1+KEY2 - indicates press and hold down keyl and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the ¢ key. The keys
are always indicated with capital letters.

e keylkey2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the c key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering

The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of frequently consulting the printed manuals.

All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.

The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).

Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus

The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.

The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

Mew Project

Open project
Welete Projest
Brinter Setup
Help

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.

To choose a command from a menu, use the following procedures:

B Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window

The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:
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Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

Zoom - : click this icon to return to the original scale of the preview.
Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

Print: click the print icon to send the drawing to the default printer.

Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows

The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.

When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

GRIDDING PARAMETERS |

Calculation algarithm
Order aof the polynomial zurface [-]

wWeighted Average of Polunomial 5o

Meshgize (] o 125
Threshold distance [m] ... RERD
“Weighting exponent [-] ... ]
kinimum # coardinate [m] ... L]
b axirnurn & coordinate [m] ... 795
kinimum " coardinate [m] ... 770

b axirurm v coordinate [m] ... L]

Range of the # coordinates TE0 < ¢ 3128
Range of the ' coordinates M < T < 286
Range of the £ coordinates ... Mi< =< 2145

ok | LCancel | Help |

T he calculation of the grid can be performed using the Kriging or the Weighted Average of Polynormial
Surfaces; a zero-order polynomial suface iz a zpecial caze that coresponds to the ardinary
irverse-diztance weighted average method.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
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The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.

To scroll the list box and select an item, do as follows:

B click the arrow, and then click the item to be selected.

press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.

Tere are three buttons in the dialogue window:

e <Ok> - this button saves the entered information and goes on to the next phase.

e <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

e <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:

/B click the button

press alt+underlined letter
To edit the data inside the dialogue window, use the following keys:

e TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

e ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

e BACKSPACE - cancels the last character that has been entered.
e DEL - cancels the character to the right of the cursor.

e ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

e UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.
e LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.
e HOME -moves the cursor to the beginning of the field.

e END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables

Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

e TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

e SHIFT+TAB - moves the cursor to the previous button.

e ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

e PAGE UP - moves the cursor up 15 lines.

e PAGE DOWN - moves the cursor forward 15 lines.

e UP ARROW - moves the cursor to the input field directly above.

e DOWN ARROW - moves the cursor to the input field directly below.

e LEFT ARROW / RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current
position.

e HOME - moves the cursor to the beginning of the line.
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e END - moves the cursor to the end of the line.

e F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.

DATAPOINTS EDITING
|

Puaint| # Coord. [m]| ' Coord. [m]| Elevation [m]| Mame AI

|

T he planimetric coordinates should be entered [in metres] from an
arbitrary onigin.
ok | LCancel | Irzert | Delete | Help |

The tables have two additional buttons:

e <lInsert> - creates an empty line before the one in which the cursor is positioned.

e <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:
The data entered in the table can be copied in order to be pasted into another table.

To copy the table’s contents:

press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.
To paste the Clipboard contents into the table:

press the key combination SHIFT+INS, Or CTRL+V.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows

The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

WARNING!

It iz not pozzible to edit data before having opened a file.
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Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.
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Chapter 7 - Introduction to the ISOMAP module

Introduction to the ISOMAP module

ISOMAP is the module that is used to calculate and render surfaces through contour lines or coloured and
shaded areas with a high degree of precision. The program allows the representation of the surface both in
topographic map and perspective view forms.

The calculation is performed in two stages. The first stage consists of creating a regular grid from a collection of
arbitrarily positioned points. The second stage consists of drawing the surface using the previously created grid.
The first stage can be performed using three methods: the inverse distance method, the kriging method, and a
new interpolation and extrapolation method based on a weighted average of polynomial surfaces.

The use of this polynomial algorithm makes it possible to generate points that are external to the area of the
sampled locations in such a way as to maintain the trend of the surface, even when this surface cannot be
approximated by a simple horizontal plane.

This feature is especially useful for those problems that deal with the surface gradient, such as flow line tracing
or rockfall analysis. The commonly used extrapolation algorithms based on the weighted average (including
kriging) can lead to large errors, for example to the inversion of the flow direction in the peripheral areas of the
map.

The use of a polynomial algorithm to create a grid also yields a more realistic surface of the area where the
sampled locations can be found, as the evaluation is less sensitive to the spatial distribution and point density.
The regular square grid is then interpolated with bi-cubic splines to obtain a continuous surface that is
continuously differentiable and which passes through the grid nodes.

The ISOMAP module has the following basic operations:

e Grid Generation

e Slope Map

e Exposure Map

e Grid Difference

e Linear Transformation
e Filtering

e Grid Duplication

e DTM Import

These operations are described later in this chapter.

If you are working with the ISOMAP-ROTOMAP package, the following operation is also available:

e Rockfall Analysis

This operation is described in the chapter dedicated to the ROTOMAP module.

Grid Generation (ISOMAP module)

The basis of any project is the generation of a regular grid. The square grid is generated using one of the
available methods, starting from a set of arbitrarily positioned points sampled on the surface under examination.
The more regular the disposition and density of the input points are, the more reliable the final result will be,
regardless of which calculation method is used. Let us consider the calculation methods that can be used.

Weighted Average

The value for unsampled locations is equal to the weighted average of the values of the nearby samples. The
weighted average takes the following form:
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n n
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i=1 i=1

where:

Z'(p) = estimated value at point p

Z(i) = sampled value at point i

D(i,p) = distance between point p and point i
alpha = weighting exponent

n = number of sampled points

This kind of interpolation is unbiased if the sum of the weights equals one. This is true for the inverse-distance
weighted method because the sum of the weights divided by the sum of the weights is equal to one.

The exponent on the distance function above can be altered. Altering the exponent on the distance affects the
relative weights of the points. In all cases, a sample that is further from the point to be estimated will receive a
lower weight.

As the exponent is increased, the relative influence of more distant points decreases.

A problem that exists with this method is that you have to make a guess at what the exponent should be, and
there is no assurance that your guess is correct.

Kriging

The Kriging algorithm, also called “best linear unbiased estimator”, was developed for mining geology. It is
“best” because it minimizes the error variance in the estimate, “unbiased” because the weights sum to one, and
“linear” because it is a simple weighted average. It also uses a weighted average method to calculate the value
at unsampled locations, but rather than guessing at the relationship between similarity of values and distance
(like we do when we guess at the exponent in inverse-distance methods), the relationship is calculated from the
data using the semivariogram.

Once the lognormal semivariogram has been calculated, the weights L(i) can be obtained to estimate the value
of an unsampled location. The Kriging takes the following form:

Z'(p) = D (z(i)* LGy
i=1

where:

Z'(p) = estimated value at point p
Z(i) = sampled value at point i

n = number of sampled points

This set of weights has the property Z LGi) =1

and guarantee the minimisation of the general expression that represents the variance of the error associated to
the estimate relative to point p.
n

n n
2~ Z(L(i)* G(D(i,p)) - 9(D(p. p)) - (Z(L(i)* L(j)* G(D(i, 1))
i=1 i=1j=1
n n n
2~ Z(L(i)* G(D(i,p)) - 9(D(p. p)) - (Z(L(i)* L(j)* G(D(i, 1))
i=1 i=1j=1

where:

G(D(x,y)) = average variance associated to the distance between the points x and y

n = number of sampled points

This minimisation is obtained through the solution of a system of n+1 linear equations.

Method of the Weighted Average of Polynomial Surfaces

One of the greatest problems of the previously described methods is the impossibility of estimating values
outside the range defined by the maximum and minimum values of the sampled points. This problem has the
immediate consequence of preventing one from extrapolating, in a significant way, the values beyond the area
that is actually covered by the sampled points.

Hydrogeology or rockfall analysis applications, based on the treatment of partial derivatives of the surface
(gradients), are in fact extremely sensitive to irregularities, even small ones, of the surface.

For this reason a more complex algorithm has been made available, that is based on an auxiliary polynomial
estimator Z"(i) which represents the regional trend of the variable under examination.
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The estimate therefore assumes the following form:

n n
Z'(p) =Y @0 aoi.nn/ D anin

i=1 i=1

where:

Z'(p) = estimated value at point p

Z"(i) = estimated value in function of the value assumed at point i
D(i,p) = distance between point p and point i

alpha = weight exponent

n = number of sampled points

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Grid Generation” in the “Operation” window

- Use the “Edit Points” in the “Edit” menu to input the spot sampled points

- Use the “Grid Parameters” in the “Edit” menu to choose how the grid will be calculated
- Select “Calculation” on the menu bar

Slope Map (ISOMAP module)

With this command, the program creates a grid that contains the slope (in degrees) of a topographic surface.
It is possible to choose whether the program has to calculate the maximum or the average slope of the ground

around each node of the grid. As i, | are the grid node indexes and | is the mesh size, we obtain:

maximum slope =

ymax(z(i +1, ) - 2(i, ), 26 -1, j) - 200, 1)) /17 + max(z(i, j +1) - 2(i, }), 26,  -1) - 2(3, [))° /1

average slope =

J@G+1 ) =26 -1 )21 A%+ (2, ) +1) - 2(, j —1)2 1 A2

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Maximum Slope Map” or “Average Slope Map” in the “Operation” window
- Select the project that contains the original topographic surface

- Select “Calculation” on the menu bar

Exposure Map (ISOMAP module)

With this command, the program creates a grid that contains the angle from the North of the dip direction of the
ground. The Y-axis must be oriented to the North. The South direction will result to be equal to 180°; both the
East and West directions will be equal to 90°.

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Exposure Map” in the “Operation” window

- Select the project that contains the original topographic surface
- Select “Calculation” on the menu bar

Note: as an alternative, it is possible to obtain interesting results working on the original topographic surface
using a horizontal Light Vector.

Grid Difference (ISOMAP module)

With this command, the program creates a new grid that is calculated as the node-by-node subtraction of two
given grids. A typical application could be the evaluation of the removed ground, which is obtained by
subtracting two grids that represent the topographic surface before and after an excavation.
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It is mandatory that the two grids have the same number of rows and columns.

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Grid Difference” in the “Operation” window

- Select the project to extract from the “minuend” grid

- Select the “Select Subtrahend Grid” command from the “Edit” menu

- Choose an existing project (of the same grid size) to extract from the “subtrahend” grid
- Select “Calculation” on the menu bar

Linear Transformation (ISOMAP module)

The linear transformation operator makes it possible to perform a linear transformation of the surface,
performing the following three sequential operations for each node:

1. sums a first translation factor (a);
2. multiplicates by a scale factor (b);
3. sums a second translation factor (c).

The general formula z'=(z+a)*b+c makes it possible to perform any linear transformation such as the Celsius-
Fahrenheit conversion, with a=0, b=9/5 and c=32.

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Linear Transformation” in the “Operation” window

- Select the project to be transformed

- Select the “Linear Transformation Parameters” command from the “Edit” menu
- Select “Calculation” on the menu bar

Filtering ISOMAP module)

This operator performs a numerical filtering in the space domain, that is to say, the convolution of a matrix
operator of order 2n+1 with the grid itself.

The filters should always be symmetrical to the axis that passes through its centre, and to the two diagonals.

By using a unit matrix one will obtain a grid that is the moving average of the original grid. By using this
command in conjunction with the Grid Difference operation, one can, for example, separate the local gravity
anomalies from the regional ones.

Procedure

- Select the “New Project” command from the “Project” menu
- Choose a new name for the project

- Select “Filtering” in the “Operation” window

- Select the project to be filtered

- Select the “Select Filter” command from the “Edit” menu

- Choose a filter (you can create a new one with a text editor)
- Select “Calculation” on the menu bar

Grid Duplication (ISOMAP module)

This command enables one to duplicate a project, for example to allow parametric analyses.
It can also be used to create a new grid from an existing one, changing the extension of the grid and the size of
the mesh.

Procedure

- Select the “New Project” command from the “Project” menu

- Choose a new name for the project

- Select “Grid Duplication” in the “Operation” window

- Select the project to be duplicated

- Assign the new values of Xmin, Xmax, Ymin, Ymax and of the Mesh Size
- Select “Calculation” on the menu bar
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Note: the X,Y values must be inside the ranges of the original grid.

DTM Import (ISOMAP module)

With this command, it is possible to import regular grid data from other programs and convert these into the
ISOMAP format. A default ISOMAP format can be used, or a custom made filter can be developed on request.
The data files must previously have been created, with a text editor such as Notepad, and have the “.ZRE”
extension.

The structure of the ZRE files is quite simple: on the first line write the number of nodes on the X-axis, on the
second line write the number of nodes on the Y-axis, on the third line write the mesh size (in metres) between
two nodes, in the two next lines write the abscissa and ordinate of the first grid node in the bottom left corner.
The file can now be completed with the Z-values, column by column (left to right), each column in a bottom-up
order. Each column of Z-values must be preceded by a line that contains the text “Column #”, where # is the
column number. Once the file is saved, the import procedure can be started.

Procedure

- Select the “New Project” command from the “Project” menu
- Choose a new name for the project

- Select “Import ZRE file” in the “Operation” window

- Choose the ZRE file you want to import the grid from
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Chapter 8 - ISOMAP family - General
Commands

Project Menu (ALT,R)

This menu contains all the commands that are used to open and delete the files which contain all the project
data. As long as the project name has not been defined, the other menu items are disabled.

| Project Edit Celoulate Fiint Esit Help

Mew Project

Open project
Welete Projest
Brinter Setup
Help

The last opened projects are shown in the lower part of this menu.

New Project Command (ALT,R,N)

In order to operate with this program, it is necessary to open a project; this can be a new project or an already
existing one. To open a new file:

Lok, jr: |E data j @l ﬁl
1 eng
[ esp

I fra
I Dita

File name: || Open I
Files of twpe: IISDMAP j Cancel |
A

B choose the New Project command from the menu by first clicking the Project menu item and then on
the New Project command. Type the name of the new file in the File Name field and confirm.

choose the New Project command from the menu by using the combination of the keys ALT,R,N. Type
the name of the new file in the File Name field and press ENTER.

The name of the file in use will be reported in the title bar of the main window.

The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate any
extension, since the extension “.NFJ” is automatically added: for example, given the name “TESTO01", the file
name “TESTO01.NFJ" will be internally used by the program.

When opening a new project, it is necessary to choose which operation has to be performed. Only one
operation can be associated to each project name, and it cannot be changed later on.

It is possible to create a series of projects, each of which uses the results of a previously elaborated project as a
“starting point”: this will be the Source Project.
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| Eenbe Lilleremees

' Sopenmpena e Effects
| Uiraw asnchiones

I ] o e 1 e
= Bozkifall Anabesis

T Grd Difference

" Lanea lsansloisation
" Fiering

T Awerage Slope

" Menimiam Slope

" Expoat

T Gl
A gL e

Ok |

See "Introduction to the ISOMAP module" for information about the Grid Generation, Slope Map, Exposure Map,
Grid Difference, Linear Transformation, Filtering, Grid Duplication and DTM Import operations.

There is no specific command In the program to save data, as these are automatically saved after each data
entry or elaboration.

Open Project Command (ALT,R,0)

In order to operate with this program, it is necessary to open a project; this can be a new project or an already
existing one. To open an existing file:

Lok, jr: |E data j @l ﬁl
1 eng
[ esp

I fra
I Dita

File name: || DOpen I
Files of twpe: IISDMAP j Cancel |
A

B choose the Open Project command from the menu by first clicking the Project menu item and then on
the Open Project command from the menu. Type or double click the name of the new file in the File
Name field and confirm.

choose the Open Project command from the menu by using the combination of the keys ALT,R,0. Type
the name of the file in the File Name field then press ENTER. Otherwise press TAB and then the up
ARROW Or DOWN ARROW to select the name from the list, then press ENTER.

The name of the file in use will be reported in the title bar of the main window.
There is no specific command In the program to save data, as these are automatically saved after each data
entry or elaboration.
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Delete Project Command (ALT,R,D)

This makes it possible to delete all the files pertaining to a project. Before using this command, one should be
sure that these data are no longer necessary. Particular care must be taken if the project has been used as a
Source Project for other elaborations. Before deleting the files, the program asks for confirmation.

Printer Setup Command (ALT,R,P)

When selecting this command, one calls the printer configuration dialogue window. Here one can verify and
modify the default printer setup or select another printer from the list of the installed ones.

Print Menu (ALT,P)

The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.

El1soMAP 32
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Parameters Command (ALT,P,P)
With this command, the “Graphical Parameters” dialogue window is shown.

The “Graphical Parameters” Dialogue Box

The " Graphical Parameters" dialogue window allows the configuration of most of the graphical parameters (see
also the “Configure” item of the Print menu).

e Map, Wireframe View, Solid View: one can here choose the representation type.
The three buttons on this dialogue window allow one to select different parameter sets.

<Geometric Parameters> Button

e Scale: this is the scale factor that has to be used in the graphical output. It is the denominator in the fraction
l:scale

e Labelled contour lines interval: this is the elevation difference between two labelled contour lines. One ought
to remember that the number of lines is inversely proportional to the given interval. A too small interval will
slow down the drawing speed.

e Unlabeled contour lines interval: this is the elevation difference between adjacent unlabeled contour lines.
One ought to remember that the number of lines is inversely proportional to the given interval. A too small
interval will slow down the drawing speed.

e Smooth factor: this is the number of elements into which each grid element is divided, in order to represent
more detailed contour lines; the larger this number the more accurate and attractive the drawing will be. If a
high value is used there will consequently be a longer computing time and a larger file size, which increase
proportionally with the square of the Smooth factor. If the Smooth factor is equal to one, a special faster
algorithm is used. The Smooth factor value can vary between one and nine.

e Minimum Z coordinate: this defines the minimum threshold value of the contour lines that have to be
represented. This parameter can be useful, for example, when plotting concentration contour lines where it
would be erroneus to represent negative values. The range between minimum and maximum is an open
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interval.

Maximum Z coordinate this defines the maximum threshold value of the contour lines that have to be
represented. This parameter can be useful when one wants to eliminate values that are too high, such as
the borders of polynomial extrapolations.

Zero range to hide: this parameter allows one to hide the contour lines close to zero. This option is useful,
for example, for the representation of magnetometric data.

Vertical exaggeration factor: this factor enables one to stress the drawing, thus enhancing the anomalies of
the plotted quantity.

Viewpoint distance: this is only used in the Solid View. It is the absolute distance (in meters) between the
viewpoint and the centre of the grid. This parameter is not used in the Wireframe View, because, in this
case, the viewpoint distance is considered to be infinite.

Viewpoint Vector X , Y, Z components: these define the direction of the viewpoint from the centre of the grid.
The program disregards the vector magnitude, and automatically considers only the direction. It is used both
in the Solid View and in the Wireframe View.

Light Vector X , Y, Z components: these define the direction of the light point from the centre of the grid. If
the three coordinates are equal to zero, no light effect is added. These parameters are used in the Map and
in the Solid View.

Sampled locations: one can decide if and how the sampled locations will be drawn. The available options
are: a simple cross, a cross labelled with the value of the sample, a cross labelled with the name of the
location, or no representation at all.
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<Vectors and Titles> Button

Flow vectors: with this option it is possible to draw flow vectors as small arrows positioned on the grid
nodes. There are three options: Direction - unit vectors are drawn, oriented towards the dip direction;
Velocity - the velocity vectors are drawn, as defined in Darcy’s law, with the lengths proportional to the
product of the hydraulic head gradient and the hydraulic conductivity; Gradient - flow vectors are shown as
arrows oriented towards the dip direction: the vector length is proportional to the dip of the surface. No
vector is drawn with the No Vector option.

Vector step: this is used to space the vectors further apart; when assigning a value equal to 3, a vector, for
example, will be drawn every three grid nodes.

Vector length / mesh width ratio: the maximum (or unit) length of the vectors is, by default, equal to the
mesh width. It is possible to to alter this value by assigning a vector length / mesh width ratio that is different
from one.
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Lines: this is used to draw a set of continuous flow lines. The required data are: the X,Y coordinates of the
end points of an imaginary segment, and the number of equally spaced points along this segment through
which the flow lines will pass.

Titles: entering a title or sub-titles is not mandatory.

Legend Caption: when a Map or a Solid View is coloured, a legend is automatically added. It is possible to
add a caption to describe the plotted quantity.

Legend check box: unchecking this box, the legend will not be plotted; this option is useful to export a
“clean” graphic output to other programs like GIS.
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<Colour Selection> Button

Number of colours lower than: the program automatically detects the optimal contour line intervals, using
multiples of 1.0E", 2.0E" and 5.0E". Setting the Number of colours lower than parameter, the program is
forced to choose a value of the contour line interval that produces a number of contour lines (and colour
ranges) lower than the given value.

“Reset intervals” button: this button activates a procedure that recalculates the contour line intervals as a
function of the previous parameter.

Scale type: the colour shade distribution can be organised using different scale types: linear, inverse linear,
logarithmic, inverse logarithmic, quadratic or inverse quadratic.

Colour type: the colour sets can be generated in different ways: Black and White, Red, Green, Blue,
Multicolour, and Random. With the Black and White option one obtains a grey-scale output; With the Red,
Green or Blue option the selected colour shades towards white; the Multicolour options allows one to create
outputs using a continuous scale of colours, and the Random option assigns a colour that is randomly
chosen to each level.

Disable surface colouring: when this option is activated, the program does not colour the areas between the
contour lines.

R/G/B shade to black: with this option the selected colour will shade towards black instead of towards white.

Disable contour lines: when this option is activated, the program no longer draws the contour lines; if both
surface colouring and contour lines are disabled, nothing appears on the graphical output.

Remove violet from multicolour: this option allows one to start the multicolour scale (if selected) from the
blue instead of from the violet colour.

Use manual colour settings: one can choose to manually define the contour line values and the colours to fill
the area between the adjacent contour lines. To manually define those parameters, click the <Manual
Colour Setting> button.

The <Copy Colour Set> Button: If the current interval number is lower than 21, the "Manual Colour Setting"
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dialogue box is opened, and the current settings are copied and can then be modified, otherwise the button
is disabled.
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The <Manual Colour Setting> Button

The <Manual Colour Setting> button opens the "Manual Colour Setting" dialogue box, where you can define the
contour line values and the colour one wishes to assign to each interval. These settings can be saved as
personalised colour profiles.

Mamal Coboui S ebling

To change a colour, double click the coloured field and choose the new colour to be assigned to the interval
from the Colours Dialogue Box.

Each time a colour set has been defined and confirmed, it is saved as a default manual colour profile. It will then
be used each time the Use manual colour settings option is selected, if a different colour profile has not been
loaded or saved; in this case, the default colour profile is overwritten, and the selected (saved or loaded) colour

profile will be permanently associated to the current project, regardless of the default manual colour
configuration.

e <New Profile> button: if the current interval number is lower than 21, the current automatic settings are



28 - ISOMAP & ROTOMAP for Windws - User Guide

copied and can then be modified, otherwise all the fields are cleared.

e <Read Profile> button: the program reads a previously saved colour profile from the hard disk; this colour
profile will be permanently associated to the current project.

e <Save Profile> button: this allows one to save the current colour profile on the hard disk; this colour profile
will be permanently associated to the current project.

Print Grid Command (ALT,P,G)

With this command, the Print Preview window is opened and the plot is shown; it is then possible to directly print
the graphical output, or export it to different formats.
For more information: The Graphical Output Preview Window

Print Vertical Section Command (ALT,P,V)

With this command, a window is shown that allows the graphic output of a ground vertical section to be
configured.

The “Vertical Section Configuration” Dialogue box

A certain number of points along a given line are calculated and plotted as a vertical section. The required
parameters are:

YWeitscal Seoteen Configurstion

Huorizontal scals 1: {1000
Werlical soabs 1: ||[|[|
Abroives Diycmate
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e Point Distance: distance between two adjacent calculated points along the given line [m].

o Reference Elevation: elevation of the reference plane [m].
e Horizontal Scale: horizontal scale of the graphical output.

e Vertical Scale: vertical scale of the graphical output. The scales are separated to allow a vertical
exaggeration factor.

e Abscissa, Ordinate: the X and Y planimetric coordinates of the nodes of the line, from the arbitrary origin
used to create the grid, along which the calculated points are aligned.

e Ok Button: the print preview window is shown, and the vertical section is plotted.

e Cancel Button: this is used to abort the current operation.

Export in SLK Format Command (ALT,P,S)

With this command, a window is shown to allow one to select which quantity has to be exported as an SLK file
(a format that is compatible with Microsoft Excel and other spreadsheets).

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.
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COLOUR SELECTION

—Colours
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One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.

Click an object to select it (use the scroll bar to see the entire list)

Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

It is possible, as an option, to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.

Exit Menu (ALT,X)

This command allows one to exit the program. There is no specific command to save the entered data as these
are automatically saved each time they are modified.
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Chapter 9 - ISOMAP Menus - Grid Generation

Edit Menu (ALT,E) - Grid Generation

This menu is used to enter and edit the input data used in the gridding operations.

Project Edit_ Calculate  Print Exit Help

D ata Points
Gridding Parameters
Hidden pdezh Selection
Help

m)|=

Data Points Command (ALT,E,P)
This enables one to enter and edit the input data points.

The “Data Points” Dialogue box

The following data should be entered in the “Data Points” window:

X and Y Coordinates: the planimetric coordinates should be entered (in metres) from an arbitrary origin.
Elevation: the ground elevation (or another physical quantity) that has to be represented on the Z-axis.

Name: this is an optional caption of the data points. There are two special characters that can be added at
the beginning of the point names (notice that those characters will not be printed on the graphical output):
when the point name begins with the @ character, the value will be used in the calculation but will not be
printed; when the point name begins with the # character, the data point will be printed (if one of the
Sampled locations options has been selected) but will not be used in the calculation.
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Gridding Parameters Command (ALT,E,G)

The Isomap module creates a regular grid that calculates the values of the physical quantity for each node of a
square mesh using different interpolation algorithms. The required parameters are entered in the Gridding
Parameters dialogue box.

The “Gridding Parameters” Dialogue Box

The following data are entered in the “Gridding Parameters”:

GRIDDING PARAMETERS

Calculation algorithm
Order of the polynomial surface [-]

Mezh zize [M] . 125

Threzhold distance [m] .o CSatan]
Wwieighting exponent [-] . F)

Minimurm & coordinate [m] ..., 350

b asirmum # coordinate [m] e, 005

Minimum " coordinate [m] ..., 230

b asirmum v coordinate [m] e, 55

Fiange of the = coordinates 00 < % < 3125
Fiange of the ' coordinates AT < 256
Fiange of the £ coordinates 0z < 2145

ok LCancel Help

T he calculation of the grid can be performed uzing the Kriging or the Weighted Average of Palynaorial
Surfaces; a zero-order polynomial suface iz a special case that comezpondsz to the ardinary
inverse-distance weighted average method.

e Calculation Algorithm: the calculation of the grid can be performed using the Kriging or the Weighted
Average of Polynomial Surfaces; a zero-order polynomial surface is a special case that corresponds to the
ordinary inverse-distance weighted average method.

e Order of the polynomial surface: the basic concept of the Weighted Average of Polynomial Surfaces is that
the best fitting polynomial surface is calculated, as a first step, from the data points, then a gradual vertical
shift allows one to obtain a final surface that passes through the sampled locations. Going away from the
sampled points, the calculated surface converges to the best fitting polynomial surface. A zero-order
polynomial surface (Z = a) is a special case that corresponds to the classic inverse-distance weighted
average method. A fist-order polynomial surface (Z = a + b X + ¢ Y) is a dipping plane that gives, for
example, a good approximation for a simple water table only sampled in three wells. The surfaces of the
second and third order are more complex and can better approximate a surface with many sampled
locations. These surfaces require a homogeneous distribution of the sampled points because the gradient of
the surface rapidly increases as it becomes distant from the sampled area.

e Mesh size: the mesh size (in metres) should be such as not to exceed 500 grid elements along each X and
Y axe; if this value is exceeded, the mesh size is automatically adjusted.

e Threshold distance: this is the radius (in metres) of the circle wherein the points that will be considered to
calculate a single grid value lie. As the used methods are based on an inverse-distance weighted average, it
could be a good idea to keep this value sufficiently large so as to consider all the sampled points in the
calculations, thus also obtaining a smoother surface with a small mesh size.

e Weighting exponent: this is the exponent that is applied to the inverse distance which is used in the
weighted averages. The greater the exponent, the greater is the influence of a sampled point on the
calculated grid. This means that too small exponent values can generate a surface with “peaks” around
each sampled point, while too large exponent values can generate a “benched” surface. Values between 4
and 6 can normally yield good results.

e Minimum X coordinate: together with the ordinate of the lower side, this defines the lower left corner of the
grid.

e Maximum X coordinate: together with the ordinate of the upper side, this defines the upper right corner of
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the grid.

e Minimum Y coordinate: together with the abscissa of the left side, this defines the lower left corner of the
grid.

e Maximum Y coordinate: together with the abscissa of the right side, this defines the upper right corner of the
grid
Example

Example: an original surface, with data points regularly sampled on each grid node, has been made denser to
show the effect of the Weighting exponent. The best result has been obtained with Exponent = 3.

|
il

Original surface Exponent = 3
Exponent values 1 and 2 produced a surface with “peaks” around each sampled point (particularly emphasised
with the minimum value); on the other hand, Exponent values 4 and 8 produced a “benched” surface
(particularly emphasised with the maximum value).

Exponent =1 Exponent = 2 Exponent = 4 Exponent = 8

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes. A graphical editing window is opened and the grid is
shown: by default, all the meshes are not hidden, and appear as green squares.
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The following procedure allows one to hide some meshes:

<Hidden>/<Shown>: select one of the two option buttons to choose whether to hide or show the meshes.
The hidden meshes will appear as red squares.

A single left-click assigns the currently selected status to a single grid mesh. Holding down the left button
and moving the mouse over the grid allows a continuous (multiple) selection of the meshes. Finally, a right-
click fills an area that is delimitated by a line of previously selected meshes.

<Cancel editing>: cancels the very last editing operation.
<Save>: saves the selection of hidden meshes.

<Cancel>: closes the window without saving any modifications.

Calculate Menu (ALT,C) - Grid Generation

With this menu, one can calculate the regular grid using the entered data points and the previously defined
parameters.
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Execute Calculation Command (ALT,C,E)
With this command, the program generates the grid. Use the print menu to view the results of the elaboration.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface; enter the coordinates of the point
in the window and click the <Calculate> button.

= Z(X.Y) Calculation 3|
x| |
Y |
Z | |

LCalculate | E xit |

The program calculates the required value using a bi-cubic splines interpolation algorithm, and displays the
result in the "Z" field.

Print Menu (ALT,P)

The Print menu is used to configure the graphical output and to plot the surface in Map, Wireframe View or Solid
View form.
For more information, see the Print Menu - Common Commands.
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Chapter 10 - ISOMAP Menus - Slope Map

Edit menu (ALT,E) - Slope Map

With this command, the program creates a grid that contains the slope (in degrees) of a topographic surface.
When creating the new project, it is possible to choose whether the program has to calculate the maximum or
the average slope of the ground around each node of the grid.

Project Edit_ Calculate  Print Exit Help

Ol = Hidden Mesh Selection
Help

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Calculate Menu (ALT,C) - Slope Map

This menu allows one to calculate a grid that contains the slope of a topographic surface (in degrees).

Execute Calculations Command (ALT,C,E)

This command allows one to calculate the slope of a topographic surface (in degrees).
Use the print menu to view the results of the elaboration.
For more information, see the Slope Map Operation.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.

Print Menu (ALT,P) - Slope Map

The Print menu is used to configure the graphical output and to plot the surface in Map, Wireframe View or Solid

View form.
For more information, see the Print Menu - Common Commands.
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Chapter 11 - ISOMAP Menus - Exposure Map

Edit menu (ALT,E) - Exposure Map

With this command, the program creates a grid that contains the angle from the North of the dip direction of the
ground. The Y-axis must be oriented to the North. The South direction will result to be equal to 180°; both East
and West directions will be equal to 90°.

Hidden i

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Calculate Menu (ALT,C) - Exposure Map

This menu allows one to calculate the angle from the North of the ground dip direction.

Execute Calculations Command (ALT,C,E)

This command allows one to calculate the angle from the North of the ground dip direction.
For more information, see the Exposure Map Operation.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.

Print Menu (ALT,P) - Exposure Map

The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the Print Menu - Common Commands.



37 - ISOMAP & ROTOMAP for Windws - User Guide

Chapter 12 - ISOMAP Menus - Grid Difference

Edit menu (ALT,E) - Grid Difference

With this command, the program creates a new grid that is calculated as the node-by-node subtraction of two
given grids. A typical application could be the evaluation of the removed ground, which is obtained by
subtracting two grids that represent the topographic surface before and after an excavation.

It is mandatory that the two grids have the same number of rows and columns.

0J
m

Help

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Select Subtrahend Grid Command (ALT,E,G)

This command allows one to choose an existing project (of the same grid size) to extract from the “subtrahend”
grid

The “Select Subtrahend Grid” Dialogue Box

To select a file, type the name of the project to extract from the “subtrahend” grid in the File Name field, or
browse the hard disk and double-click the project file name.

Calculate Menu (ALT,C) - Grid Difference

Once selected the Subtrahend Grid, this menu allows one to calculate the grid difference as the node-by-node
subtraction of the two given grids.

Execute Calculations Command (ALT,C,E)

Once selected the Subtrahend Grid, this command calculated the grid difference as the node-by-node
subtraction of the two given grids. Use the print menu to view the results of the elaboration.
For more information, see the Grid Difference Operation.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.
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Print Menu (ALT,P) - Grid Difference

The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid

View form.
For more information, see the Print Menu - Common Commands.
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Chapter 13 - ISOMAP Menus - Linear
Transformation

Edit Menu (ALT,E) - Linear Transformations

The linear transformation operator makes it possible to perform a linear transformation of the surface,
performing the following three sequential operations for each node:

1. sums a first translation factor (a);
2. multiplicates by a scale factor (b);
3. sums a second translation factor (c).

The general formula z'=(z+a)*b+c makes it possible to perform any linear transformation such as the Celsius-
Fahrenheit conversion, with a=0, b=9/5 and c=32.

amplel

Exit Help

iD = Hidden i
Linear Transformation Parameters

Help

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Linear Transformation Parameters Command (ALT,E,T)
This command enables one to define the parameters for the linear transformation.

The “Linear Transformation Parameters” Dialogue box

In the “Linear Transformation Parameters” dialogue window the following data are required:

LINEAR TRANSFORMATION PARAMETERS

Firzt tranglation fackor ... 0
Scale fachar ..o 1
Second tranglation factor ... 1]

ok LCancel Help

[t iz the 'a' constant in the lingar ransformation equation 2'=z+a)*b+c.
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e First translation factor: it is the constant a in the linear transformation z'=(z+a)*b+c formula.
e Scale factor: it is the scale factor ‘b’ in the linear transformation formula.

e Second translation factor: it is the constant 'c' in the linear transformation formula.

Calculate Menu (ALT,C) - Linear Transformation

With this menu, a linear transformation is performed on each node of the source grid.

Execute Calculations Command (ALT,C,E)

With this command, the linear transformation is performed on each node of the source grid, using the given
parameters.
For more information, see the Linear Transformation Operation.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.

Print Menu (ALT,P) - Linear Transformation

The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the Print Menu - Common Commands.
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Chapter 14 - ISOMAP Menus - Filtering

Edit Menu (ALT,E) - Filtering

This operator performs a numerical filtering in the space domain, that is to say, the convolution of a matrix
operator of order 2n+1 with the grid itself.

The filters should always be symmetrical to the axis that passes through its centre, and to the two diagonals.

By using a unit matrix one will obtain a grid that is the moving average of the original grid. By using this
command in conjunction with the Grid Difference operation, one can, for example, separate the local gravity
anomalies from the regional ones.

ISOMAP 32 - example2

P'p:uieu:t|£dit Calzulate Frant Exit Help

Select Eilker
Edit filter
Help

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Select Filter Command (ALT,E,F)
With this command, the program shows the “Select Filter” dialogue box.

The “ Select Filter” Dialogue box

To select a file, type the name of the file containing the digital filter to be used for the current operation in the
File Name field, or browse the hard disk and double-click the filter file name.

To create a new digital filter, type a new name and confirm, and then select the command Edit Filter from the
Edit menu.

Edit Filter Command (ALT,E,E)

With this command Notepad is started, and one can create or edit a custom filter.
The structure of the filters is quite simple: the order of the matrix operator is written in the first line. This should
always be an odd number. The coefficients are written in the following lines, separated by spaces.

This is an example of a filter that performs the average of the values along a circle centred on a grid node:

11

.00000 .00000 .00000 .03571 .03571 .03571 .03571 .03571 .00000 .00000 .00000
.00000 .00000 .03571 .00000 .00000 .00000 .00000 .00000 .03571 .00000 .00000
.00000 .03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571 .00000
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
.03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571
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.00000 .03571 .00000 .00000 .00000 .00000 .00000 .00000 .00000 .03571 .00000
.00000 .00000 .03571 .00000 .00000 .00000 .00000 .00000 .03571 .00000 .00000
.00000 .00000 .00000 .03571 .03571 .03571 .03571 .03571 .00000 .00000 .00000

The filters can be created with any external word-processor, shoud have the “.FIL" extension and shoud be
saved as plain text.

Calculate Menu (ALT,C) - Filtering

With this menu, the grid filtering is performed.

Execute Calculations Command (ALT,C,E)

With this command, the grid filtering is performed using the chosen filter.
For more information, see the Filtering Operation.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.

Print Menu (ALT,P) - Filtering

The Print menu is used to configure the graphical output and plot the surface in Map, Wireframe View, or Solid
View form.
For more information, see the Print Menu - Common Commands.
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Chapter 15 - Introduction to the ROTOMAP
module

Introduction to the ROTOMAP module

ROTOMAP is a three-dimensional model that is used for rockfall analysis and the design of rockfall protective
systems.

This module belongs to the Isomap family: a complete description of the main module features can be found in
the ISOMAP chapters.

ROTOMAP uses a statistical approach; it simulates a large number of rockfalls and, through the analysis of the
distribution of the average and maximum kinetic energies, identifies the optimal areas for the installation of the
protective systems.

The program requires a detailed topographic map and a geomorphologic data collection to identify the areas
where a rockfall can initiate, and to distinguish the different surface types, such as clean faces of hard
unweathered rock or surfaces covered in talus, scree or gravel material.

A digital terrain model can be obtained from an arbitrary distribution of points (X,Y,Z), that the program can
convert into a regular grid, or by directly assigning the elevation values to the nodal points of the square mesh
that is used in the model.

It is also possible to import the elevation values from an external digital terrain model.

A new, fast model calibration method is now available, thus avoiding carrying out expensive tests with high-
speed cameras. ROTOMAP draws the contour lines of the minimum travel times of the blocks; with a simple
chronometer and a standard video camera it is possible to compare the real and simulated times, in
correspondence to pre-determined check-points. This allows a detailed and reliable calibration of the model.

If in-field tests are not possible, a preliminary back-analysis stage can be used to determine the restitution and
friction coefficients. These coefficients can be obtained through a comparison of the points where the rock
blocks stop in the simulation with the rockfall history stop points.

The kinetic energy distribution is thus calculated and this permits both the optimal positioning and the accurate
design of barrier fences or catch benches.

The maximum bouncing height over the slope can also be drawn. This allows the selection of the correct size of
the barrier fences.

In this way, the effectiveness of the whole rockfall protective system can be verified.

The program can generate printouts of the topographic map, rockfall trajectories, kinetic energies, distribution of
stop points and the vertical sections of each simulated fall.

Rockfall Analysis (ROTOMAP module)

The rockfall problem is quite complex because the real behaviour of boulders, when rolling down a slope,
depends on apparently insignificant geometric and mechanical details. The interaction between the morphology
and the path taken by the boulders is not “linear”, but “chaotic”. There is, in fact, no proportionality between the
variation of the initial conditions and the variation of the fall trajectory. Very small variations in the initial
conditions normally cause large (and thus unforeseen) variations of the final conditions. This does not mean that
the problem cannot be solved: it is simply not possible to calibrate the model with only a few simulations,
therefore one cannot forecast the path and the stop point of a single real boulder. The only reasonable solution
is a statistical approach. In this way the stop points are not considered individually, but as a probability
distribution.

The geomechanical parameters used in the model are defined as normal and tangential energy coefficients of
restitution, friction coefficients of the rolling boulders and limit angle. These parameter sets should be calibrated
for a small range of block sizes, as the same material can have an elastic or plastic behaviour as a function of
the rock boulder size.

Of all the geomechanical parameters, the limit angle is perhaps the most difficult to evaluate. This parameter is
used to determine when the boulders start to bounce over the slope or return to the rolling conditions. A boulder
starts to bounce if the increase of the slope dip, or the angle of the trajectory with the ground after impact, is
greater than the limit angle. In all other cases, the fall proceeds in rolling conditions.

In order to use the Rotomap module, one should first collect data to construct the numerical model of the slope
with as much precision as possible.

It is possible to determine the parameters from scratch through a back-analysis (which is however necessary to
calibrate the final model), but an accurate initial data collection makes it possible to considerably narrow the
range of variability, within which to perform the back-analysis, and enables one to set up a truly reliable model.
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The first phase of the work would be the geometrical reconstruction of the slope. For this purpose, one should
use a detailed and up-to-date map. It would be even better to use a topographical survey specifically made for
this purpose.

The data entering shoud consist of a collection of sparse but uniformly distributed data set (X,Y,Z) that will be
transformed by the program into a regular grid, but it would be better to use points directly sampled on the
nodes of the square grid to be used in the model. It is also possible to use a pre-existing digital terrain model.

In the case of manual input of the sampled points, the grid can be oriented at the optimal angle to minimize the
data entry work.

During the choice of the size of the mesh, one should keep in mind that the choice of an excessively large mesh
will result in a reduced precision of the numerical model; on the other hand, a too small mesh size can either
simulate unexpected peaks that interact with the boulder paths, or an excessive smoothing of the slope, which
cause a drastic change in the boulder behaviour.

The mesh should be “large” compared to the size of the boulders, but “small” compared to the examined area
(the usual mesh size is generally between 5 and 15 metres).

Once the topographic surface is defined, it is necessary to make an accurate geological and geomorphologic
data collection.

Starting points: as detachments can occur at points that are not individually identifiable, the program does not
require individual points to be entered, but rather detachment lines that can be arbitrarily placed below the top of
the slope. The simulation lets the path of the boulders start from points aligned along these lines, with velocities
that vary from a minimum to a maximum, depending on the geometry of the unstable slopes.

The local behaviour along the detachment areas is ignored, and the values of the initial velocity of the blocks,
when their trajectories cross the detachment lines, can be evaluated as cs * \/(2gh) Where g is the gravity

acceleration, h is the vertical distance (h1 < h < h2) between the real detachment points and the assumed
detachment lines, and Cs is a “first bounce” coefficient <1, this being necessary to take the local impacts along
the detachment area into account.

The minimum and maximum estimated vertical distances are hl and h2, from which the minimum and maximum
initial velocities are calculated.

Geomechanical parameters: it is therefore necessary to use the geological and geomorphologic data
collection to identify the zones where homogeneous sets of restitution and friction coefficients can be assigned.
It is important to remember that the best way to assign these parameters is to perform some field tests. As an
alternative, such values can be found in literature.

Stop points: the planimetric points where, in the rockfall history, the boulders have stopped should also be
identified.

A comparison of the historical series of the stopping points with the frequency distribution calculated by the
program, can confirm whether the model has been properly calibrated.

Main features of the mathematical model
The main mathematical features of the Rotomap module are here discussed.

Three-dimensional model

The choice of using a three-dimensional model for the representation of the surface is due to the fact that the
paths followed by the boulders are not in a vertical plane, and that one cannot define a unique vertical cylindrical
surface that contains all the rockfall paths. For this reason it is strongly advised to use a surface instead of a
vertical section, and even though the two-dimensional calculations would be simpler, the three-dimensional
approach constitutes an unacceptable simplification in most cases. This concept can be clarified through an
example: a small increase of velocity can cause a boulder to pass a ridge and thus take a completely different
path.

Statistical approach

As previously mentioned, rockfall is a “chaotic” phenomenon, whose behaviour in not compatible with
deterministic forecasts. For this reason, rockfalls should be analysed from a statistical point of view. A great
number of events (hundreds or even thousands of paths) should therefore be simulated, assigning several
starting points with different initial velocities and directions along the detachment lines.

The program saves each rockfall trajectory point, recording the position of the boulder and the velocity
components for each time-step. In this way, it is possible to obtain a map of the frequency distribution of the
stop points and of the travel-time (to check the calibration of the model) and a map of the distribution of the
average or maximum kinetic energy (to design the protection systems).

Kinematical behaviour

The decision to only consider the kinematical behaviour of the centre of gravity of the boulders, thus
disregarding the angular momentum of an ellipsoidal solid, was taken after a careful evaluation of the
advantages and disadvantages of the two methods, that are here summarised:



a)

b)
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degrees of freedom

An ellipsoidal solid enables one to consider the effects of the angular momentum; this makes it possible to
accumulate a part of the energy as rotation energy that is later released as kinetic energy during the
impacts. The boulder thus assumes a behaviour that is characterised by short and long leaps, with sudden
decelerations and accelerations after each collision. It can be questioned whether this is realistic behaviour,
especially for large boulders that roll off weathered rock and scree slopes. A boulder does not really have an
ellipsoidal form, and thus it is impossible to obtain more precise “individual” simulations with this method.
Furthermore, small variations in the mass, the initial rotation speed and the ratio between the axes will lead
to completely different paths. All this simply adds redundant information to the model. The path of the gravity
centre, disregarding the angular moment, can be considered as the most probable of all the paths that can
be generated from infinite combinations of boulder shapes and initial conditions. It is possible to implicitly
take into account the angular momentum effects by correcting the ratio between the normal and tangential
restitution coefficient.

stopping criteria

A typical problem encountered in rockfall models is how to determine a valid criterion to stop the blocks. An
ellipsoidal boulder usually stops when bouncing back, or when it slows down under a given limit. This is a
rather gross simplification, especially because the concept of “back” is meaningless in a three-dimensional
model. Considering the centre of gravity alone, an exact stopping criterion based on energy balances can
be followed.

calculation time and memory usage

The calculation time and the memory usage would be onerous, as, for each time-step of the trajectory, six
more values would have to be saved on the hard disk. In this way, the number of possible simulations would
be halved. Fundamental importance has been given to the high number of simulations; as the variability of
the initial conditions assure the simulation of thousands of trajectories, the introduction of a random factor
such as the effect of the angular momentum would not introduce any improvement of the statistical analysis.

Interaction with protective systems

Barrier fences - barrier fences and catch fences are the most commonly used rockfall protective systems. The
“local” calculation of the interaction between boulders and fences is beyond the scope of this program. The
Rotomap module simulates fences with the three following parameters:

a)

b)

c)

Capacity: this is the maximum energy that the nets can absorb. The units of measurement should be
congruent with those of the boulders: the energy absorption capacity and the block mass multiplied by the
unit energy V2/2 are, in fact, compared.

Mass of the rock blocks: this is the default mass of the boulder considered in the project. A detailed analysis
of the rock mass is required to correctly define this value.

Height of the nets: one should verify that the boulders, when bouncing, do not exceed the height of the net.
As the energy of the boulders is proportional to the mass, while the rockfall paths are mass-independent, a
series of calculations obtained with constant unit mass boulders and variable energy absorption capacity
would allow one to evaluate any boulder-fence interaction through the capacity/mass ratio.

Earth or rock fill — if the slope of the earth fill is vertical, it is sufficent to add a fictitious catch fence with a very
high value of energy absorption capacity to the model. Otherwise, one can model catch benches by modifying
the terrain geometry, and assigning proper geomechanical parameters to the earth fill.

Procedure

- Select the command “New Project” from the “Project” menu

- Choose a new name for the project

- Select “Rockfall” in the “Operation” window

- Select the project to extract the topographic surface from, then:

- input the position of the detachment lines from the “Edit” menu

- input the geomechanical parameters from the “Edit” menu

- input the calculation parameters from the “Edit” menu

- optionally input the position of the barrier fences from the “Edit” menu

- Select “Calculation” on the menu bar
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Chapter 16 - ROTOMAP Menus - Rockfall
Analysis

Edit Menu (ALT,E) - Rockfall Analysis

This menu is used to enter and edit the input data used in rockfall analysis operations.

ROTOMAP 32 - examplerot? M= E

Project | Edit Calculate  Frint Exit Help

Ol Hidden Mesh Selection %EEEE %l‘/ﬁ{ﬁ@
Bockfall Parametres

Geomechanical Parameters

Placing Starting Lines

Placing Protection Systems

Help

Hidden Mesh Selection Command (ALT,E,M)

This command allows one to hide some of the grid meshes.
For more information, see the Hidden Mesh Selection - ISOMAP Menus - Grid Generation.

Rockfall Parameters Command (ALT,E,R)
This command allows defining the parameters for the rockfalls analysis.

The “Rockfall Parameters” Dialogue box

In the dialogue window “Rockfall Parameters”, the following data have to be entered:

ROCKFALL PARAMETERS

Flyirg limmit angle [7] . &
Colliding limit angle [7] ............. q
Bouncing limit angle []........... ]
Humber of starting points [-] ........ 3
3
1
5
3

Humber of initial velocities [] ...
M inirurn initial velocity [mdz] ...
b awirnuann imitial veocity [mds] ...
Murnber of initial directions [] ......
I awirnunm anguilar desaation [7] .. 12
Capacity [kd] oo ]
Boulder mags [H].............. .0
Height of the nets [m] ..o ]

] LCancel Help |

Thiz parameter iz uzed to determing when the boulders start to fly over the slope. & boulder starks to fly if
the increasze of the slope dip is greater than the limit angle.

e Flying limit angle: This parameter is used to determine when the boulders start to fly over the slope after a
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bounce. A boulder starts to fly if the the angle of the trajectory with the ground after an impact is greater than
the limit angle.

Colliding limit angle: This parameter is used to determine when the boulders start to fly over the slope. A
boulder starts to fly if the increase of the slope dip is greater than the limit angle.

Bouncing limit angle: This parameter is used to determine when the boulders impact with the ground and
bounce. A boulder bounces if the decrease of the slope dip is greater than the limit angle.

Number of starting points: this is the total number of starting points aligned along one or more starting lines.
As detachments happen at points that are not individually identifiable, the program does not require
individual points to be entered, but rather lines of detachment that can be arbitrarily placed below the top of
the slope. The simulation lets boulders start from points aligned along those lines, with velocities that vary
from a minimum to a maximum, depending on the geometry of the unstable slopes.

Number of initial velocities: this is the number of starting velocities for each starting point. The simulation lets
boulders start from points aligned along those lines, with velocities that vary from a minimum to a maximum,
depending on the geometry of the unstable slopes. The local behaviour along the detachment areas is
ignored, and the values of the velocity of the blocks, when their trajectories cross the detachment lines, can
be evaluated as Cs V (2 g h) where g is the gravity acceleration, h is the vertical distance between the real
detachment points and the assumed detachment lines, and Cs is a “first bounce” coefficient <1, which is
necessary to take local impacts along the detachment area into account, h can be either the minimum or
maximum estimated vertical distances that give the minimum and maximum initial velocities.

Number of initial directions: this is the number of initial directions chosen in a given interval around the dip
direction. To obtain a good statistical analysis, a large number of events (hundreds or even thousands of
paths) should be simulated, assigning a large number of starting points along the detachment lines, with
different initial velocities and directions. The total number of rock falls is calculated as follows: Number of
initial directions * Number of initial velocities * Number of starting points.

Minimum and maximum initial velocities: these values define the range of initial velocities of the rock blocks
(see above for suggestions about how to calculate those values). The velocities are expressed in m/s.

Maximum angular deviation: this value defines the range (+/- the maximum angular deviation) of the interval
around the dip direction, in which the starting directions are chosen. It is expressed in degrees.

The next three values refer to the interaction between boulders and protection systems. Note that the rockfall
paths are mass-independent, and a series of calculations obtained with constant unit mass boulders and
variable energy absorption capacity would allow one to evaluate any boulder-fence interaction through the
capacity/mass ratio.

Capacity (kJ): this is the maximum energy absorption capacity of the protection system.

Boulders mass (t): this is the mass value of the boulders which, multiplied by the v?/2 value and compared to
the barriers capacity, allows one to evaluate whether the protection system has been properly designed.

Height of the nets (m): the program is able to simulate both flying and rolling paths; it can thus verify whether
the blocks are bouncing over the protection systems or not.

Geomechanical Parameters Command (ALT,E,G)
This command allows one to assign the geomechanical parameters to each grid mesh.

The geomechanical parameters used in the model are defined as coefficients of restitution of normal and
tangential energy, and friction coefficients of the rolling boulders.

A graphical editing window is opened, and the grid is shown, with the contour lines of the ground elevation.The
following procedure allows one to assign the parameters:

<Geomech. Param.>: in the text boxes beside the option button, one has to write the three parameters,
separated by commas:

- coefficient of restitution of normal energy,
- coefficient of restitution of tangential energy,

- friction coefficient of the rolling boulders
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Once the parameters have been written, select one of the parameter sets by clicking the option button.

A single left-click assigns the currently selected parameter set to a grid mesh. Holding down the left button and
moving the mouse over the grid allows a continuous (multiple) selection of the meshes. Finally, a right-click fills
an area delimitated by a line of the previously selected meshes.

e <Cancel editing>: cancels the very last editing operation.
e <Save>: saves the assigned geomechanical parameter sets.

e <Cancel>: closes the window without saving any modifications.

Placing Starting Lines Command (ALT,E,P)

This command enables one to define planimetric coordinates of the starting lines. As detachments happen at
points that are not individually identifiable, the program does not require individual points to be entered but
rather starting lines that can be arbitrarily placed below the top of the slope. The simulation lets boulders start
from points aligned along those lines. The detachment lines cannot be placed on the grid border.

The “Placing Starting Lines” Dialogue Box

In the “Placing Starting Lines” window, the following data are entered:



e X Coordinate: the X and Y planimetric coordinates of the starting lines should be defined in metres, from the
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PLACING STARTING LINES

Pairt| ¥ Coord, [m]] % Coord. [m]|  Code| = |

—_
]

—_
—

—_
[

1

1
1

e | L

(5]

hd
The > and " planimetric coordinates of the starting lines

zhould be defined in metres, from the arbitrary origin uzed to
create the grid.

ok | LCancel | Inzert | Delete | Help |

arbitrary origin used to create the grid.

e Y Coordinate: the X and Y planimetric coordinates of the starting lines should be defined in metres, from the

arbitrary origin used to create the grid.

e Code: it is possible to define one or more starting lines. For this reason it is necessary to assign a code to
each point of the starting lines: every point must have code=1, except the initial point which should have
code=0. For example to define two separated lines, with 4 and 3 points respectively, the sequence of codes

mustbe: 0,1,1,1,0, 1, 1.

Placing Protection Systems Command (ALT,E,S)
This command allows one to define the lines along which the barrier fences are positioned.

The “Placing Protection Systems” dialogue box

In the “Placing Protection Systems” dialogue window, the following data are entered:

PLACING PROTECTION SYSTEMS |

Paint

al

—_
=

—_
—_

—_
2

1

1

Rl LR

1

Lo

» Coord, [m]| ' Coord, [m]] Code| Capacity [kJ]] Height of the nets [m]

The ¥ and ' planimetric coordinates of the protection systems should be defined in
metres, from the arbitrany orgin used to create the grid.

] | LCancel | Inzert | Delete | Help |
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e X Coordinate: the X and Y planimetric coordinates of the protection systems should be defined in metres,
from the arbitrary origin used to create the grid.

e Y Coordinate: the X and Y planimetric coordinates of the protection systems should be defined in metres,
from the arbitrary origin used to create the grid.

e Code: it is possible to define one or more starting lines. For this reason it is necessary to assign a code to
each point of the starting lines: every point must have code=1, except the initial point which should have
code=0. For example to define two separated lines, with 4 and 3 points respectively, the sequence of codes
mustbe: 0,1,1,1,0,1, 1.

e Capacity (kJ): this is the maximum energy absorption capacity of the protection system, individually asigned
to each section of the net.

e Height of the nets (m): height of the nets, individually asigned to each section of the net. The program is
able to simulate both flying and rolling paths; it can thus verify whether the blocks are bouncing over the
protection systems or not.

Calculate Menu (ALT,C) - Rockfall Analysis

With this menu, one can choose the calculation which has to be performed.

ROTOMAP 32 - examplerot? [_ O] x]
Fioject Edit | Calculate  Print Exit Help
T Rockfall Calculation I]Q:I:I Ifﬁ @_
D Bl Stop Point Calculation T H v @@‘@l
Awverage Energy Caloulation
tawimum E nergy Calculation
timirmurn Travel-Time Calculation
b gwimum Height Calculation
Z[# 1] Caloulation
Help

Rockfall Calculation Command (ALT,C,R)

The rockfalls are calculated with this command. Notice that each path is identified by a progressive number; this
allows one to choose a single rockfall and printing it as a vertical section. A preview window is shown, and the
first path is calculated, then the program pauses: clicking the “>* button, the next path is calculated; clicking the
“>>" putton, all the paths are calculated. At each moment it is possible, clicking the “>* button, to interrupt the
automatic sequence and return to the one-by-one mode.

Three other buttons are available in the rockfall calculation preview window:
e <Interrupt Single>: clicking on this button interrupts the current path calculation.
e <Interrupt All>: clicking on this button definitively interrupts the calculation of the paths.

e <Confirm>: closes the rockfall calculation windows.

Stop Point Calculation Command (ALT,C,P)

Through this command, one can calculate the frequency distribution of the stop points. This distribution is
expressed in stop points per square metre per million of paths.

If in-situ tests are not possible, a preliminary back-analysis stage can be used to determine the restitution and
friction coefficients. These coefficients can be obtained by comparing the points where the rock blocks stop in
the simulation with the real stop points in the rockfall history. If one compares the historical series of stop points
with the frequency distribution calculated by the program, it is possible to confirm whether the model has been
properly calibrated.

Please note that this form of representation is dedicated to back analysis, and only takes into account the final
position of the blocks. Thus, it cannot be considered a hazard map.
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Average Energy Calculation Command (ALT,C,E)

Through this command one can calculate, for unit mass rock blocks, the average energy distribution (v*/2).
The average kinetic energy distribution permits an optimal positioning of barrier fences or catch benches.

Maximum Energy Calculation Command (ALT,C,M)

Through this command one can calculate, for unit mass rock blocks, the maximum energy distribution (v°/2).
The maximum kinetic energy distribution permits an optimal design of the capacity of the protection systems.

Minimum Travel Time Calculation Command (ALT,C,T)

Through this command, one can calculate the minimum travel times of the blocks.

A new, fast calibration method of the model is now available, instead of expensive tests with high-speed
cameras. ROTOMAP draws the contour lines of the minimum travel times of the blocks; with a simple
chronometer and a standard video camera, it is possible to compare, in correspondence to pre-determined
check-points, the real and simulated times. This allows a detailed and reliable calibration of the model.

Maximum Heights Calculation Command (ALT,C,A)

Through this command, one can calculate the maximum bouncing height of the rock blocks over the slope.
This allows one to select the safe size of the barrier fences.

Z(X,Y) Calculation Command (ALT,C,C)

With this command, one can evaluate the “z” value of any point of the surface.
For more information, see the Z(X,Y) Calculation - ISOMAP Menus - Grid Generation.

Print Menu (ALT,P) - Rockfall Analysis

The Print menu is used to configure the graphical output, and to plot the surface in Map, Wireframe View, or
Solid View form.
For more information, see the Print Menu - Common Commands.
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Parameters Command (ALT,P,P)

With this command, the “Graphical Parameters” dialogue window is shown.
For more information, see the Parameters Command - Common Command.

Physical Quantities Selection Command (ALT,P,Q)
With this command one can select which physical quantities should be superimposed in the final graphical

output.
The “Physical Quantities Selection” dialogue window.

Clicking the check boxes of this window it is possible to superimpose two or more different physical quantities in
the same graphical output. The available quantities are:
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e Topography: contour lines of the ground elevation.

e Stop Points: contour lines of the frequency distribution of the stop points. This distribution is expressed as
number of stop points per square metre per million of paths.

e Minimum Travel Time: contour lines of the minimum travel time of the blocks. This allows a detailed and
reliable calibration of the model.

e Maximum Heights: contour lines of the maximum bouncing height over the slope of the rock blocks. This
allows one to select the safe size of the barrier fences.

e Average Energy: contour lines of the average energy distribution (v’/2). The average kinetic energy
distribution permits an optimal positioning of barrier fences or catch benches.

e Maximum Energy: contour lines of the maximum energy distribution (v?/2). The average kinetic energy
distribution permits an optimal design of the capacity of the protection systems.

e Rockfall paths: the path taken by the rock blocks while rolling down the slope.

Print Grid Command (ALT,P,G)

With this command the Print Preview window is opened and the plot is shown; it is then possible to directly print
the graphical output, or to export it into different formats.
For more information: The Graphical Output Preview Window

Print Vertical Section Command (ALT,P,V)

With this command, a window is shown that allows one to configure the graphical output of a ground vertical
section.
For more information, see the Print Vertical Section Command - Common Command.

Print Rockfall Sections Command (ALT,P,R)

Through this command the window “Rockfall Sections preview” is invoked, and this enables one to visualise and
print the rockfalls one-by-one.

Enter the rockfall number from which to start, then click on the “Preview button”: the boulder path is shown on
the screen as a cylindrical section of the topographic surface that passes through the selected path. The
qualitative distribution of the kinetic energy is also shown.

Clicking on the “>" and “<" buttons one can go forward or back in the sequence of the rockfalls.

Clicking the <Print> button the selected rockfall is plotted in the Print Preview window.

For more information: The Graphical Output Preview Window

The "Section Print Parameters” dialogue box

By clicking on the <Parameters> button one can enter a main title and some subtitles, the drawing scale factor
and the reference elevation for each rockfall. The lowest value of Z is normally assumed as the reference
elevation; the possibility of defining another value enables one to normalise the reference plane for more
drawings thus making their comparison easier.
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T he main fitle will be showvn an the first ine of the output, withe a larger font size than the sub-titles. Title
and zub-titles are optional.

Export in SLK Format Command (ALT,P,S)

With this command the “Export in SLK Format” window is opened, and it is then possible to export a grid as a
SLK file, that is compatible with Excel and other common spreadsheets.

Clicking the option buttons, it is possible to select one of the physical quantities that should be exported into the
SLK format. The available quantities are:

Topography: table of the ground elevation.

Stop Points: table of the frequency distribution of the stop points. This distribution is expressed in number of
stop points per square metre per million of paths.

Minimum Travel Time: table of the minimum travel times of the blocks. This allows a detailed and reliable
calibration of the model.

Maximum Heights: table of the maximum bouncing height of the rock blocks over the slope. This allows one
to select the safe size of the barrier fences.

Average Energy: table of the average energy distribution (v’/2). The average kinetic energy distribution
permits an optimal positioning of barrier fences or catch benches.

Maximum Energy: table of the maximum energy distribution (v’/2). The average kinetic energy distribution
permits an optimal design of the capacity of the protection systems.

Geomechanical Parameters: table of the coefficients of restitution of normal and tangential energy, and
friction coefficients of the rolling boulders.

Configure Command (ALT,P,C)

With this command, one can define the properties of the different objects in the graphical output.
For more information, see the Configure Command - Common Command.
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Chapter 17 - Miscellanea

Reported values for coefficients of restitution

Reference
Habib (1977)

Descoeudres et
Zimmermann (1987)

Broili (from
Pasquero (1987))

Piteau and Clayton
(from Pasquero (1987))

Hoek (1987)

(based on unpublished
information from
Departments of
Transportation in USA)

Pfeiffer, T.J., Bowen,
T.D. (1989)

Robotham, M.E., Wang,
H., Walton, G. (1995)

Budetta, P., Santo, A.

Value forr

0.75-0.80
0.50 - 0.60

0.40
0.80

0.75-0.80
0.20-0.35

Value for rp,

0.65-0.75
0.45-0.65

0.35-0.45
0.2-0.3

0.53
0.40
0.35

0.32
0.32
0.30

0,37-0,42
0,33-0,37

0,3-0,33
0,3-0,33
0,28 - 0,32
0,28 - 0,32

0,315
0,303
0,315
0,251
0,276
0,271

0,2

0,1

Value for ry

0.8-0.9
0.5-0.8

0.4-0.5
0.2-04

0.9
0.90
0.85

0.82
0.80
0.80

0,87 -0,92
0,83-0,87

0,83 -0,87
0,8-0,83
0,8-0,83
0,78 - 0,82

0,712
0,615
0,712
0,489
0,835
0,596

0,53

0,2

Remarks

Based on experience in Italy
Based on experience in Norway

Vineyard slopes
Rock slopes

Rock to rock impact
Rock to soil / scree impact

Type of material on slope surface

Solid rock

Detrital material mixed with large
rock boulders

Compact detrital material mixed with
small boulders

Grass covered slopes

Clean hard bedrock

Asphalt roadway

Bedrock outcrops with hard surface,
large boulders

Talus cover

Talus cover with vegetation

Soft soil, some vegetation

Hard surface paving

Bedrock or boulders with little soil or
vegetation

Talus with little vegetation

Talus with some vegetation

Soft soil slope with little vegetation
Vegetated soil slope

Limestone face

Partially vegetated limestone scree
Uncovered limestone blast pile
Vegetated covered limestone pile
Chalk face

Vegetated chalk scree

Dolomitic limestone boulders on rocky
surfaces and on talus desposits
Remolded pyroclastic from the terraces



Chau, K.T., Wong, R.H.
C., Lee, C.F. (1996)

Giani, G.P. (1992)

Pfeiffer, T.J., Higgens,
J.D. (1990)

Hungr, O. Evans, S.G.
(1988)

References
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0,393
0,453
0,487

0,5

0,35

0,3

0,25
0,37-0,42
0,33-0,37

0,3-0,33
0,28-0,3

0,5

0,5

0,7

0,24

0,87 -0,92
0,83-0,87
0,82-0,85
0,8-0,83
0,78 -0,82
0,8

0,8

0,9

situated at the base of the cliff
Impacts on detritus of the fans present
at the foot of a rock cliff

Soil
Shotcrete
Rock slope

Bedrock

Bedrock covered by large blocks
Debris formed by uniform distributed
elements

Soil covered by vegetation

Smooth hard surfaces and paving

Most bedrock and boulder fields

Talus and firm soil slopes

Soft soil slopes

Smooth hard surfaces such as pavement
or smooth bedrock surfaces

Most bedrock surfaces and talus with no
vegetation

Most talus slopes with some low
vegetation

Vegetated talus slopes and soil slopes
with spares vegetation

Brush covered soil slope

Sparsley forested slope is covered by a
veneer of very fine weathered talus
derived from weak shistose units
underlying the limestone cap.
Limestone on bare uniform talus slope
formed of basalt fragments with a modal
size of 5 cm.

Rectangular bolder of metamorphosed
tuff on bare rock and a steep snow
covered shelf.
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